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Creating a video suitable for Vodcast Using Quicktime

What will you need?
Hardware & Software

Computer .

Apple Desktop machine or iMac
iBook , Powerbook or MacBook Pro

Video Recording There is a range of possibilities for the recording, and review, of captured video...

Software D

Built in iSight Camera

Digital Video Camera with appropriate cable ~ USB or Firewire
Digital Still Camera with video recording capability plus cable
Small tripod

Quicktime
Podcast Maker
iTunes

Built in iSight Camera Digital Video Camera

Headset

Digital Camera with Movie Record (mic shown)

DV Cam Firewire Cable
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Subject matter resources

Storyboard or script

Publishing the vodcast

Web server space
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What is the purpose of the vodcast?

Do you know what you wish to say? Can you simply speak to your topic straight off the top of
your head or will you need a set of notes, script or storyboard to guide you through the podcast?
What is the duration of the vodcast? One minute or thirty minutes?

Do you have access to a web server on which you can publish the necessary vodcast files?

Do you know the ftp address of the server that you will use to publish your vodcast?

Do you know the address of the exact directory on the server where you will publish your vodcast?
Do you have password access to the server?

Will you need technical assistance from an IT support staff member who can take care of this final
process for you?

Is the server at school? Is it your own server?

Do you know how to obtain the subscription address of the vodcast so that you can share it with
others so that they may review your vodcast?

Setting up for the recording on your Apple computer ~ getting the audio correct

1. System Preferences

It is wise to check your audio set-up before you begin working with Quicktime. This About This Mac
may save some troubleshooting later.

Select System Preferences... from the Apple menu.

The window illustrated will appear.

Software Update...
Mac OS X Software...

System Preferences...

Dock [ 2
Location >
Recent Items >
Force Quit Safari XOED
Sleep

Restart...

Shut Down...

Log Out John Larkin... {#Q

8060 System Preferences
[ | [ ShowaAll | Q

Personal

= W M @E e Q

Appearance Dashboard & — Desktop & Dock International  Security Spotlight
Exposé  Screen Saver

Hardware

\er F. I\

v [ Y ¢ L &\

Bluetooth  CDs &DVDs  Displays Energy Keyboard &  Print & Fax Sound
Saver Mouse

Internet & Network

® 6 Q @

Mac Network  QuickTime Sharing
System
= n
2R & @ ¢ O @
Accounts  Date & Time  Software Speech  Startup Disk  Universal
Update Access

Other

pr .

@ @ - K

DivX FlipdMac Perian Sticky Windows
WMV

Click on the Sound icon at the end of the listed Hardware items in the second row. The following window will appear.
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eo6o Sound

(<) Gowar) a

I Sound Effects Output | Input }

Choose a device for sound input

Name Port
Built-in

Internal microphone
Line In Audio line-in port

Logitech USB Headset USB

Settings for the selected device:

Input level: ssesseeennnnnNnNn
Input volume: k_!g 6‘

Output volume: 6 ‘))) ™ Mute

1 1

gShow volume in menu bar
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Click on the Input tab on the right and select the desired method for recording your audio. You have may have two or more choices. In the

example below there are three choices:

Choose a device for sound input

Name Port

Internal microphone Built-in

Line In Audio line-in port
USB

Logitech USB Headset

Internal omni-directional microphone (eg; located under left speaker grille)

Choose a device for sound input

| Name Port
Built-in

Internal microphone
Line In Audio line-in port

Logitech USB Headset USB

Line in ~ mini-jack stereo input jack for a stereo microphone

Choose a device for sound input

Name Port
Internal microphone Built-in
Line In Audio line-in port
USB

Logitech USB Headset

Headset input is via USB
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Click on the Output tab in the centre and select the desired listening for your audio. In the examples illustrated below one could choose

between the internal speakers or the Logitech USB headset.

860

(< -] (rowar)

Sound

(

Sound Effects | Output | Input -

)

Choose a device for sound output

Name
Internal Speakers
Logitech USB Headset

Settings for the selected device:

Port
Built-in Output
USB

Balance:
left

1
right

Output volume:

-

8 Show volume in menu bar

© o)) & Mute

Internal speakers selected

60

(<] (rowar)

Sound

[

Sound Effects | Output | Input

)|

Choose a device for sound output

Name
Internal Speakers
Logitech USB Headset

Settings for the selected device:

Port
Built-in Output
USB

Balance:
left

<J

1
right

-

Output volume:

g Show volume in menu bar

—— ) DMute

Logitech USB Headset selected
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Working with Quicktime

Locate Quicktime in your Applications fo

Ider or within your Dock

000 | A Applications 3
R = N
[« » J[58]= m{ %] Q
! Macintosh HD o o P 2
(¥ Desktop D & @
A john e :
1) Podifier Preview ProfCast
7~« Applications
6 Music -~ =
'} Documents g s @ =
| Pictures
t’, etur QuartzCube QuickTime Player Quiz Press
[ieg Movies
(¥ Microsoft Entourage o - = m
L Microsoft Word = @ =
&' Adobe Photoshop CS
) Rapid Weaver f RealPlayer ReelBean b
[ www_main -
T 137 items, 10.11 GB available 7

o JOTR (< b | |

Double click on the application to launch it. No windows will appear unless it is the first time that you open the application.

Setting Preferences in Quicktime

You can set Preferences in Quicktime as well. Select Preferences... from the Quicktime menu.

The window illustrated below will appear.

About QuickTime Player

Preferences... a8,
QuickTime Preferences...
Registration...

Update Existing Software...

Buy QuickTime Pro
Services >

Hide QuickTime Player #H
Hide Others \#H
Show All

Quit QuickTime Player #¥Q
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e OO Recording =
o B g
General Full Screen Recording
Video Source: ' DV-VCR B
Microphone: = Automatic ‘ :]
Quality: ' Better (H.264) -
Better for email and web sharing.
640x480 video, 128 kbps AAC audio
Save files to: (g Desktop s
Click on the Recording button so that you can set the appropriate video and audio input settings.
Video input Automatic

Setting the video input. If you wish to use a digital video
camera take the opportunity to connect it to your Macintosh
with the appropriate cable and switch it on. You can set it to
Camera mode.

Select DV-VCR to use your camera.

If you have an iSight camera you can select it.

Audio input

To secure better audio quality it may be wise to utilise a
headset.

Choose the audio input that suits your needs.

Close the window when you have completed making your settings.

v Built-in iSight
DV-VCR

v Automatic

Built-in Input: Line In

Logitech USB Headset

Built-in Microphone: Internal microphone
DV-VCR

Capturing your video and exporting to iPod video format

Select New Movie Recording from the File menu.

New Player #BN
New Movie Recording X 3N
New Audio Recording AX#EN
Open File... #0
Open URL... #U
Open Image Sequence... ¢ ¥#0

Open Recent >

Click on the Record button to begin your video recording.

Click on the Stop button to conclude your video recording.

eon Movie Recording

00:00:00 0.0 MB

(w)
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When you stop recording the movie will open. A window like 8606 3 Movie.mov
the one illustrated at right will appear.

[Hopefully the image on your video will be somewhat more
attractive than the one depicted here]

[ 000005 = 2 |

- PR -

Exporting your video to a format suitable for vodcasting or use on an iPod Video.

Select Export... from the File menu. m Edit View Window Help
New Player #BN
New Movie Recording #EN
New Audio Recording ~X#8N
Open File... #0
Open URL... #U
Open Image Sequence... %80
Open Recent 4
Close #’W
Save £
Save As... 0 #8S
Revert to Saved
Share... S
Export... BE
Page Setup... 3P
Print... #P
The window at right will appear. Notice the two drop 006 Save exported file as...
down menus at the bottom of the window. This is where
you will be able to set the desired video output settings. Save As: |Movie.mov fa)
You will normally work with the Export menu. ) -
< | [EHII]\ | Vodcast Project L Q search
® John Larkin's Co... | Name 4| Date Modified
=} Macintosh HD
{3 Desktop
@ john
A Applications
& Music
1 Documents g
Pictures
ﬂ Movies
Microsoft Entour...
Microsoft Word
Adobe Photosho...
[ www_main
Export: " Movie to QuickTime Movie =% ( Options... )
Use: " Most Recent Settings e
(" New Folder ) (" Cancel )
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Select Movie to iPod from the Export drop down menu.

Save the movie in an appropriate folder on your
Macintosh. You can rename the movie if you wish.
Notice the .m4v format.

Click on the Save button.

The following progress bar will appear. This process
may take some time depending on the length of your
video.
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Movie to 3G

Movie to Apple TV

Movie to AVI

Movie to BMP

Movie to DivX

Movie to DV Stream
Movie to FLC

Movie to Hinted Movie
Movie to Image Sequence
Movie to iPhone

Movie to iPhone (Cellular)

Movie to MPEG-4

Movie to Picture

Movie to QuickTime Media Link
Movie to QuickTime Movie
Movie to Windows Media
Sound to AIFF

Sound to AU

Sound to Wave

v Movie to iPod

Save exported file as...

®

Save As: Movie.m4v

(< ») [§1|:|I|’ | Vodcast Project a

Q search

& John Larkin's Co... | Name

=} Macintosh HD

@ Desktop
4 john
/A Applications
& Music
*y Documents
. Pictures
Microsoft Entour...
Microsoft Word
' Adobe Photosho...
L’,, www_main

| Date Modified

Export: Movie to iPod

)

Options...

Use: Default Settings

New Folder

)

(Gnes) @)
)

060 Export
Export Movie.mdy

——

Exporting - about 1 minute remains

Once the movie has completed the Export process iTunes will launch and your new movie will be listed in the Movies folder. Click on it

to play the movie.

LIBRARY

ﬂ Music

&= TV Shows
('i“ Podcasts
[ Audiobooks
{" Radio

STORE

YouTube - David Bowie - Suffragette City
YouTube - Eric Schmidt, Web 2.0 vs. Web 3.0
YouTube - M. Ward Chinese Translation
YouTube - mw
20070524-730-referendum_video4

(] Now Playing

- C————— O

6 items, 20.5 minutes, 74.1 MB - - 4
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Capturing your video and exporting to an alternative Quicktime Movie format

You can also experiment with other formats depending
on your needs. Record another piece of video as above
and select Export from the file menu.

Select Movie To Quicktime Movie from the drop down
Export menu

Click on the Options button and the window at right will
appear.

Here you can alter the following settings:

¢ Video compression
* Video filter

* Video dimensions
* Sound quality

¢ Streaming

To begin, click on the Video Settings button.

006

Save exported file as...

(«[») ([Em)

= John Larkin's Co.
= Macintosh HD

[@ Desktop

4 john

A Applications

& Music

1 Documents

Pictures

& Movies
Microsoft Entour...
Microsoft Word
Adobe Photosho...

Save As:

Movie.mov @

s

( |~ Vodcast Project o Q search

} Name 4| Date Modified

[ www_main
Export: Movie to QuickTime Movie m ( Options... )
Use: Most Recent Settings m
(" New Folder ) " Cancel |
Movie to 3G
Movie to Apple TV
Movie to AVI
Movie to BMP
Movie to DivX
Movie to DV Stream
Movie to FLC

Movie to Hinted Movie

Movie to Image Sequence
Movie to iPhone

Movie to iPhone (Cellular)
Movie to iPod

Movie to MPEG-4

Movie to Picture

Movie to QuickTime Media Link
Movie to Windows Media
Sound to AIFF

Sound to AU

Sound to Wave

Movie Settings

@ Video

" Settings... ) Compression: MPEG-4 Video
Quality: Medium

Key frame rate: 24

(_Filter... ) gitrate: 6400 kbits/sec
[ Size... ) Dimensions: 320x240

_ Allow Transcoding

™ Sound
" Settings... ) [Format: AAC
Sample rate: 22.050 kHz

Channels: Mono
Bit rate: 48 kbps

E Prepare for Internet Streaming

m (Settings... 9

( Cancel )

" Hinted Streaming
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The window at right will appear. As you can see you can
fine tune the video to meet your requirements.

In this example we will simply alter the Compression
Type.

Select H.264 from the Compression Type drop down
menu.

Click OK in the Video Compression Settings Window.

Now, click on the video Size settings button.
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Standard Video Compression Settings
Compression Type: H.264 )—C’
Motion Data Rate
Frame Rate: Current B: fps Data Rate: (8 Automatic
O Restrict to kbits/sec

Key Frames: () Automatic

@ Every 24 frames Optimized for: Download
OAl
E Frame Reordering
~C ~Preview
Quality
Lea’st Lo'w Medium High B‘est
Encoding: @) Best quality (Multi-pass)
(O Faster encode (Single-pass)
@ o)
A

DVCPROS50 - NTSC
DVCPROS50 - PAL
Graphics

H.261

H.263

JPEG 2000
Motion JPEG A
Motion JPEG B
MPEG-4 Video
None

Photo - JPEG
Planar RGB

PNG

Sorenson Video
Sorenson Video 3
TGA

TIFF

Video

Movie Settings

E Video

Compression: MPEG-4 Video
Quality: Medium

Settings...
= Key frame rate: 24
Bitrate: 6400 kbits/sec
Dimensions: 320x240

__ Allow Transcoding
@ Sound

( Settings... )

Format: AAC

Sample rate: 22.050 kHz
Channels: Mono

Bit rate: 48 kbps

E Prepare for Internet Streaming

Q (Settings...)
o)

Hinted Streaming
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The window at right will appear Export Size Settings
Dimensions: 320 x 240 QVGA -5
"] Preserve aspect ratio using: Letterbox

(if required)

"] Deinterlace Source Video

Select 320 x 240 QVGA from the Dimensions drop Current
down menu. Compressor native

Click OK in the Size Settings window. 160 x 120

176 x 144 QCIF
352 x 288 CIF
640 x 480 VGA
768 x 576 SD
1280 x 720 HD
1920 x 1080 HD

NTSC 720 x 480 4:3
NTSC 720 x 480 16:9
NTSC 720 x 486 4:3
NTSC 720 x 486 16:9
PAL 720 x 576 4:3
PAL 720 x 576 16:9
HD 1280 x 720 16:9
HD 1440 x 1080 16:9
HD 1920 x 1080 16:9

Custom

Click on the Sound Settings button. Movie Settings
E Video

e Settings... )\ Compression: MPEG-4 Video
Quality: Medium
- = Key frame rate: 24

A ———
Size... Dimensions: 320x240

__ Allow Transcoding
g Sound

( Settings... Format: AAC
Sample rate: 22.050 kHz

Channels: Mono
Bit rate: 48 kbps

@ Prepare for Internet Streaming

Hinted Streaming m (_Settings... )
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The window at right will appear. In the Sound Settings
window you can alter the following parameters:

* Sound format

*  Number or channels (mono, stereo, etc)
¢ Rate

*  Quality

* Bitrate

Select AAC from the Format menu and then select
44.100 from the Rate drop down menu.

Select a bit rate of 160 from the Bit Rate drop down
menu.
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Sound Settings

Format: "AAC

3

Channels: Mono [

“r
(N

Rate: 22.050 (%) kHz
") Show Advanced Settings

Render Settings:

Quality:  Better 4

AAC Encoder Settings:

Target Bit Rate: 48 %) kbps

I Play Source

Recommended

16
20
24
28
32
40
48
56
64
80
96
112
128
192
224
256
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Once you have completed all the Sound Settings click Sound Settings

OK to close the window.
Format: " AAC H
Channels: | Mono Iy
Rate: 44.100 (3) kHz

") Show Advanced Settings

Render Settings:

Quality: | Better i)

AAC Encoder Settings:

Target Bit Rate: 160 @ kbps
( Preview ) _ Play Source

( Cancel @

You have completed all of the settings. Do they match Movie Settings
the settings at right? # Video
Click OK to close the window. Settingeg gmﬁ;es::;: H'264

Key frame rate: 24

Frame reordering: yes
—————— Encoding mode: multi-pass

\ Size... ) ' Dimensions: 320x240

( Filter... )

| Allow Transcoding

# sound
“Settings... ) Format: AAC
osnes: ) Sample rate: 44.100 kHz

Channels: Mono
Bit rate: 160 kbps

E Prepare for Internet Streaming

\VHinted Streaming m ( Settings... )

Cancel @

Rename the movie as appropriate and browse to an 006 Save exported file as...
appropriate folder on your Macintosh. Click the Save
button. The movie will be saved to that folder. Save As: |Vodcast_01.mov (a)
If you need to play it on an iPod as well you can open <) Em 5 Vodcast Project B (@Qsearch
the movie using iTunes. Drag the movie onto the iTunes ® John Larkin's Co... | | Name 4| Date Modified
application icon or an opened iTunes window. =} Macintosh HD Movie.mé4v Today
{3 Desktop
Select the movie and then select Convert Selection for 4 john
L
iPod from the Advanced menu in iTunes. It will A Applications
. . . . Musi
duplicate the movie and convert it to an iPod format. § Music A
4 Documents
Pictures
Open Stream... #U i@ Movies
Subscribe to Podcast... Microsoft Entour...

Microsoft Word

Convert Selection for iPod Adobe Photosho...

Convert Selection for Apple TV [ www_main

Consolidate Library... Export: { Movie to QuickTime Movie q (_Options... )
Use: Most Recent Settings -5

Get Album Artwork

Get CD Track Names (New Folder ) (Cancel ) (Save)

Deauthorize Audible Account...

Vodcasting the movie... please refer to my Podcast Maker instructions:

http://www.larkin.net.au/024_podcasting/navcon2K7/002_podcastmaker.doc
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